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I. Welcome
Welcome to The World’s Shortest Excel Book. You are just a dozen major
concepts away from a much better understanding of Excel.

TWSEB Updated for 2011

A lot has happened to Excel since I first wrote and sold TWSEB about 2004.  I
could write for several pages on new features to Excel 2007 and 2010.  But for
me, the most powerful Excel feature is a spreadsheet that has grown from 65536
rows to over 1,000,000 rows.  TWSEB is written for both Excel 2007 and Excel
2010.

30 Pages or Less
In my 2004 edition of The World’s Shortest Excel book I worked very hard to
cover complex topics in 2 pages.  In this edition I may allow myself 3 pages for
a major concept.  But ultimately, this is a short ebook used to empower “smart
people who love ideas” but are a little uncomfortable with numbers.

I know YouTube and extensive videos are popular on the Internet, but I still
believe there is a place for a short ebook that you can read off and on for a
few days or a week that will make you better at Excel, faster than you ever
imagined.

This e-book came with practice files

When you purchased The World’s Shortest Excel Book you downloaded a
WinZip file. That file when unzipped contained this document and all of
your Excel practice files.

Read TWSEB and Join My Forum
In 2004 I sold only an ebook: The World’s Shortest Excel Book. But for
2011 and onward, I encourage you to join and use the Your Excel Coach
forum.  My paid forum is my classroom for helping reader’s with quick advice
on their specific Excel questions.  I can’t build your spreadsheets for you, but I
can guide you with good Excel coaching on solving your spreadsheet
problems.

Good Luck
If you have any comments drop me an email at rich@YourExcelCoach.com .
(In the subject of your email, please include the phrase twseb). Read your
e-book and use its techniques as soon as possible. Good luck!

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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II. Comparing Excel 2003, 2007, and 2010
So much has changed in the Excel world in the past 8 years.  Here’s my
attempt to explain a few user interface concepts.

Excel 2003 or Older Version

This is a world of menus, menus, and more menus.  Excel 2007 replaced the
menus with ribbons.  Some people like it, some people don’t.

Excel 2007

Yes, we now have an Office button instead of the File menu.  Additionally,
Excel ribbons have replaced the extensive menus of Excel 2003.

But if the Excel ribbons seem awkward be glad that you now have over one
million rows for your spreadsheet (1,048,576 to be exact) and 16,384 rows.
That’s a whole lot more than the 65,536 rows and 256 columns of Excel
2003.  If you work with huge amounts of data, Excel 2007 is good news.

Formula functions have expanded in number from Excel 2007 to Excel 2010.
But for the average user, you won’t know the difference.

Excel 2010

Users weren’t too fond of Excel’s Office button and Microsoft replaced it with
a File menu for Excel 2010.  But users were delighted with a million deep
spreadsheet.  That remains the same.

More formula functions were added to Excel 2010, again, every day users
won’t notice.

Finally, Excel 2010 is faster at a higher level than Excel 2007.  But most of
us won’t see the difference.

What remains the same?

Ultimately, the power of Excel is found in its formula functions.  The
ingenuity of Excel is found in its pivot tables, scenario managers, and goal
seeks.  Elegance is seen in the beautiful charts that you can make.

Finally, as always, you are responsible for the quality control of the
spreadsheets you build and present.  Microsoft Word may have spell
checkers and grammar checkers, but Excel never has had a global “does
this spreadsheet make sense” feature.  You are responsible for your Q.C.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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III. What’s the Secret to Excel?
What is inheritance? What do you do when you “inherit” someone’s Excel
spreadsheet mess and you want to understand all the formulas in it? What do
you do when you’re new on the job and someone gives you his/her Excel
spreadsheet? How can you understand an inherited spreadsheet
immediately?

What’s wrong with the spreadsheet shown below?

There is a secret to Excel that displays all of your formulas not as
numbers but as logic. It’s buried in menu structure somewhere but there’s a
keystroke that reveals everything. What is that keystroke?

Use the ExcelLearningFile.xls file and the sheet named Secret to Excel.

Think about it for a while or research it. If you just want to know now, turn
the page.

The Secret to Excel is on the next page.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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CTRL ` is the answer.
Hold down the CTRL key with your left thumb. Tap the ‘ key (called the grave
key) which is one key to the left of the number 1 key towards the upper left
hand corner of your keyboard. Notice what happens.

After using CTRL ‘ can you find the error shown below?

All formulas are now shown as logical text, not numbers.

The Error: The formulas in cells C8, D8, and E8 are incorrect because they
don’t include Stock Dividend in their sum. Examine cell E8 in both
spreadsheets shown above. But all formulas in row 8 need to be changed
because all their formulas are incorrect.

To return your formulas to displaying just numbers do another CTRL `
keyboard command. It’s a keyboard toggle. Using the CTRL ` keyboard
command, you can understand the logic behind someone else’s Excel
spreadsheet.

2007 and 2010 update:

It’s true, these versions do give us error
checking.  That’s what the green tick
marks are all about. See to the left. But
I can show you many more advanced
examples where the green error checking
symbol will not save you from bad
formulas.  Depend on CTRL ` to display
your formulas as logical text.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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IV. Formulas:  “Good” formulas can give bad numbers
It’s true. Formulas that seem to work can result in bad, inaccurate numbers.
Some people estimate that 20-25 percent of all spreadsheets have errors. It’s
not just that people want to make errors; it’s that they don’t understand
formulas.
Computers do what they have been programmed to do, not what we want
them to do. Here’s a classic from my Excel classes that demonstrates this
problem.
The Problem
Enter the numbers as shown below. Now, in cell A4, build a formula that
adds both numbers and divides by 2. This will be one cell that does two
different mathematical operations. Less than 20 % of my students in the
classroom get this problem correct.

Use the ExcelLearningFile.xls file and the sheet named MDAS Problem.

The correct answer is 100.  Did your formula in cell A4 give you the answer 125?
If you got the answer 125 you had a “good” formula that gave you a bad result.

Many clients use the formula =A1+A2/2 and that’s a “good” formula
because it gives you a result, but it’s logically “incorrect”.

What does the formula =A1+A2/2 mean to Excel?
1. Perform A2/2 which results in the number 75.
2. Add cell A1 to the value 75.
3. The formula’s value is 125.

So why doesn’t Excel do formulas from left to right like we humans expect it
to perform? Do you know the answer? Think about it. The answer is on the
next page.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com


The World’s Shortest Excel Book TWSEB - 6

Website: http://yourexcelcoach.com/
Email: rich@yourexcelcoach.com

The Answer
“My Dear Aunt Sally” is the answer. (The fancy name for this is order of
precedence.) Computers multiply and divide before they add and subtract.
Computers in general and Excel in particular don’t do what you expect them to
do. Computers behave the way they have been built or programmed to
perform. In formulas, MDAS (Multiply Divide before Add Subtract, or “My Dear
Aunt Sally”) rules everything.
The Corrected Formula

So the corrected formula from the previous page would be =(A1+A2)/2
It will give you the correct answer, the value 100. Using parentheses () in
the formula was the key to doing the formula.

Unfortunately, when it comes to Excel formulas, people sometimes forget to
use parentheses, or they use them incorrectly.

More Advice on Using My Dear Aunt Sally and Parentheses

 If your formula is getting longer and longer, you probably need
parentheses. 

 If a formula has multiplication/division mixed in with addition/subtraction,
you probably need parentheses. 

 Parentheses need to be balanced. If you have 3 left parentheses, you
need 3 right parentheses. 

 If you want to be good with formulas and Excel, referring to a high school
algebra book would be helpful. 

If you become a student of how parentheses are used in formulas, you and “My
Dear Aunt Sally” will become good at working with one another.

Good Formulas Can Produce Seriously Flawed Results
The “My Dear Aunt Sally” problem on the previous page was meant to be
easy and obvious so it appears easy and obvious.

One day I was teaching an =VLOOKUP formula to 10 people who see or use that
formula frequently. The =VLOOKUP formula is when you compare a short list of
data (perhaps 1000 records) to a longer list of records (2000). If there’s a match of
a record from the short list to the long list you extract data from the long list.

I proved to the client that if misunderstood, the =VLOOKUP formula can look
like it’s working but produce seriously flawed results. Then the clients began to
realize they needed to re-check all of their spreadsheets with =VLOOKUP
formulas for possible errors. The room was very quiet.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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V. Format Techniques Worth Knowing
I could have left these concepts out of this e-book. But I remembered when
I showed one of these techniques to a client. She said that it would save
her administrative aide hours each week.

Use the ExcelLearningFile.xls file and the sheet named Wrap Text Problem.

Wrap Text
Does the spreadsheet below look like one of your spreadsheets? If your
spreadsheet is very wide, with wide columns full of text, how do you make
the columns narrower yet still display all the text? The actual spreadsheet
had more than the two columns shown below.

The answer to this problem is a simple formatting technique. First, click on the
second column to highlight it. Second, click on Excel’s Home tab. Third, click
the Wrap Text icon in the ribbon.

Then you use your mouse to narrow your columns and to deepen your rows as
needed. See the result below.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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Orientation
If your spreadsheet has columns with narrow data (small numbers) but wide
column headers, what’s one technique for conserving left to right space? Look
at the spreadsheet shown below.

If your spreadsheet has columns with narrow data (small numbers) but wide
column headers, orientation solves the problem. You highlight the cells that
need to be changed. In this example you highlighted the names of youth
members in row three. Click the Home tab and then the Alignment button.
Use the Orientation controls in the panel to create a vertical label. The
snapshot below shows a good solution to the alignment problem.

Format Painter
Many know this technique, but there are probably just as many who don’t.

How do you copy the look of one complex cell (for example a bolded, 14
point high, Arial, red cell) to another cell? It’s easy. Click the Excel’s Home
tab.  Next, click on the cell that has the format you want to copy, and then
click on the Format Painter icon shown below. Finally, click on a plain cell.
The format of one cell is applied to another cell.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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VI. Printing - A Review, Problems, and a Few New Ideas
Even if you think you know Excel printing, please read on for a few new ideas.

Use the ExcelLearningFile.xls file and the sheet named Repeating
Column Header Problem.
The Review

 Highlight your data before you print it. (This is a good practice because it
makes you realize how wide and how long your spreadsheet will print.) 

 Click the Page Layout tab, then the Page Setup feature on the right side.


 In the Print Preview window use, Page Setup to adjust your print settings.


A Few Common Problems
“My gridlines are gone?” If your gridlines display when viewing the
spreadsheet but don’t display when print previewing, do not use borders to
create fake gridlines.

1. Click Page Layout,
2. Click Page Setup and then the Sheet tab.
3. Checkmark the Gridlines box to display gridlines for printing.

“How do I print a long spreadsheet and keep the column headers at the
top of every page?” This is a classic problem. Here’s the solution.

1. Return to Page Setup.
2. Click the Sheet tab.
3. Locate the Rows to repeat at top feature on the Sheet tab.

Finally, click the selector to the right of that field. It will take you back to the
spreadsheet. Then click the column header row. Make sure you click the row
selector tile (it’s gray) and not simply a cell. Then click the red collapse icon
to return to the Page Setup sheet. It will look like the one below.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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Then you click the Print Preview button to look at your work. You should
see that your column headers are repeating at the top of every page.

“How do I print multiple ranges at the same time?” One way is to highlight
two or more different ranges at the same time. You do this with CTRL selection
techniques (described more fully in the charting chapter). After highlighting
multiple ranges, follow these steps.

1. Click the Excel Office Button.
2. Click the Print menu choice, and then click Print again.
3. Click the Selection radio button (see below, near bottom left).
4. Finally, click the OK button to print your multiple ranges.

Idea Mapping
View the ExcelLearningFile.xls file and the sheet named Idea Mapping.  It’s an
example of flowcharting within Excel.  Here you can build your own.

1. Begin with a new worksheet and click the Excel Office Button.
2. Click Excel Options.
3. Click the Advanced choice on the left and find Display Options for

this spreadsheet.
4. De-select the Show gridlines checkbox (this affects only one

worksheet).

Then click the Insert tab, click the Shapes icon, and the Flowchart choice.
Build your flowchart with the Flowchart symbols and connect them with the
Lines objects. Draw, connect everything, think, dream, plan big.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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VII. Date Math – How old are you exactly?
How long has someone been a client? How old are your receivables? How
old is the patient? Once you understand date math you are definitely
becoming an intermediate Excel user.

Use the ExcelLearningFile.xls file and the sheet named Date Problem.

Let’s start by asking, how old are you today? How old are exactly, down to
the one-hundredth of a year? Why do we need such precision? When you
are analyzing hundreds of receivables, patients, inventory, anything, you will
need such precision.

If you’ve never done this before, it may take you a while to solve this problem.

Here’s one hint:  Every number is a date.  And every date is a number.

Here’s a second hint: Excel has a built in date timeline. Today is a
higher number than when you were born.

This sample spreadsheet may help you with your analysis.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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Solution
Remember the hint that every number is a date and every date is a number?
You can subtract dates just as easily as you can subtract numbers. So, let’s
look at your spreadsheet hint one more time.

Many beginners type in Today as a regular date. That’s okay if you want the
date to stay the same and never change. But every time you open the
spreadsheet on a different date, cell A3 needs to be re-typed to the current
date. Instead, use the formula =today() . Then whenever you open this
spreadsheet, it gives you today’s date. That saves you the trouble of re-
entering the date every day. It’s a small part of your solution, but not the big
part.

In cell B3 you enter your birthday in long date format (for example, 4/21/1951).

Calculate the Age in Days for cell C3 as the formula =A3-B3 . That’s because
Excel has a built in date timetable. Today’s date is a larger number than the
date from 1951. The result becomes a number (for example 19170) for the
person’s age in days.

Cell D3 is the formula =C3/365.25 . When you do this formula you need to
calculate for leap years. That’s why the value you divided by was 365.25,
instead of 365. As of the day I calculated the answer, the person was
52.48 years of age.

Once you understand Excel date math, you’ll start looking for new ways to
apply it to your business. For instance, you could calculate the age of
receivables, the ages of patients, length of projects as a consultant, etc.
Understanding date math opens up new possibilities in using Microsoft Excel
effectively.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
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VIII. Making Sense of Formula Functions
In the classroom I often ask, “How are formula functions like making spaghetti
sauce?” I don’t expect anyone to get the answer. But if you’re not that good with
Excel formulas, this “spaghetti sauce” analogy will help you understand

Excel formula functions a whole lot better.

Use the ExcelLearningFile.xls file and the sheet named Mortgage Problem.

Two Types of Formulas
Simple formulas. =A1+A2 would certainly be simple. Any formula that does
not begin with a function name (for example, =SUM, =AVERAGE, =RAND)
could be considered a simple formula. It’s just algebra.

Formula functions. You may have already seen or used formula functions
like =sum, =average, =count. They have words you understand and their
structure is easy to understand. For example, =SUM(A2:A19) would mean
sum up the numbers in the range A2 through A19.

Formula functions that don’t sound like English, with cell references, and
commas, are more difficult to understand. For example, what does this
formula function mean? =PMT(B5/12,B7*12,B3) Formula functions like the
=PMT function are like making spaghetti sauce. Why? Read on?
Formula functions and spaghetti sauce
What does it take to make good spaghetti sauce? Well, you need certain
ingredients. Then you need to prepare the ingredients in a certain order
(onions and green peppers sautéed first, and then added to the mix).
Sometimes you might even refer to a recipe book for guidance.

There are 200-300 formula functions in Excel. (I lost count.) Most of these
formula functions require studying the help screens or books to understand
what’s going on – like reading a recipe book. If you want to see your choices
of functions, issue the menu command Insert – Function or just click on your
paste formula icon.

As a new formula function “chef”, look again at the formula
=PMT(B5/12,B7*12,B3) . =PMT is some type of function so you need to look
it up in the help screens. There are three ingredients or variables in the
formula because they are separated by commas. And, two of the variables
are being sliced, diced, or operated on with a division symbol and a
multiplication symbol.

http://yourexcelcoach.com/
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You will want to study the function in its environment if you have “inherited”
the spreadsheet from someone else. Look at the snapshot below.

Cell B9 is the cell
we are looking at.
You can see its
=PMT formula at
the top of the
snapshot. In fact,
It’s a mortgage
calculation based
on a loan amount,
interest rate, and
years length of
loan.

But still, do your research in Excel’s help screen to study the =PMT function.
(It’s a long help screen when you find it and may be a bit confusing.)
Remember this key piece of information, it’s the “recipe”:
PMT(rate,nper,pv,fv,type).
An =PMT formula is normally a mortgage calculation and the items in bold from
the formula above must exist. Remember our formula: =PMT(B5/12,B7*12,B3).

 =PMT means that this is a mortgage calculation. 
 Rate means the monthly interest rate for the loan. In this case our interest

rate is B5/12 because cell B5 is an annual interest rate and Excel wants a
monthly interest rate in the formula. The annual interest rate is divided by 12
to give Excel a monthly interest rate.

 Nper means number of payments. Cell B7 is the number of years. Excel
wants the number of monthly payments, so multiply B7 times 12.

 PV means present value or value of the loan borrowed for the mortgage.
Cell B3 refers to the loan amount of the mortgage. 

That is why advanced formula functions are like making spaghetti sauce. You
tell Excel what function you are using, define your ingredients or variables, and
you put the variables in order. Sometimes the variables need a little math
themselves, such as multiplying years times 12 to equal total months of the
loan.

Uunderstanding someone else’s formula function is easier than building your
own. Make it a habit to write down and learn new formula functions when you
see them in use. If you become a student of the Excel spreadsheets of others,
you can learn from their good habits in using formula functions.

http://yourexcelcoach.com/
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IX. Why is =IF so important?
Once you have learned date math and a few simple formula functions, it’s time
to learn something about the =IF function. I suppose every advanced Excel
user has a bias for what is their favorite function. For me, the =IF function is a
favorite. Why? Because it’s a great problem solver.

Use the ExcelLearningFile.xls file and the sheet named =IF Problem.

Do you have a few hundred rows of data in your spreadsheet? Or perhaps you
have a few thousand. How will you find all the customers whose bills are past
30 days due? Or, in the small example below, how will you find your top
salesman and reward them with bonuses?

Take a look at the sample spreadsheet
shown to the right. Imagine that instead of
containing 8 salespeople it lists 800 sales
people throughout the country. The sales
people selling over 11,000 per month should
be complimented or rewarded while the
salespeople below 5000 may need more
training.

Conditional Formatting
If you haven’t discovered conditional formatting yet you should look it up in
Excel’s help feature. It formats certain values that are higher, lower, or equal to
certain results.  First, if you want
conditional formatting for a range of cells,
highlight those cells.  Second, click Excel’s
Home tab.  Then click on the Conditional
Formatting icon and follow your menus to
apply highlight cell rules.

Conditional formatting is a great way to go
visual.  If the value of the cell is too high or
too low, the cell appears in red (or
whatever color you specify).

http://yourexcelcoach.com/
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A Simple =IF Example
Even though conditional formatting is nice, you still need to know =IF because
it’s more powerful than conditional formatting. Conditional formatting makes for
pretty formatting, but a well built =IF statement does more. It can generate a
text message or perform a formula.

If you research =IF in Excel’s help system, you will find this formula:
IF(logical_test, [value_if_true], [value_if_false])
Explanation
=IF is normally used to analyze numbers or formulas. =IF can generate
another number or generate text. Here’s a detailed explanation of the formula
itself:
IF(you are analyzing a cell for a certain type of value, if the cell has that
number then you do something as a true operation, if the cell does not
have that number then you do something as a false operation).
Generating Text Using =IF
In the snapshot below, in cell C4 we are building an =IF formula for analyzing
cell B4. The formula is meant to work so that If cell B4 is above 11000 in sales
the salesperson gets a bonus. If it’s under 11000 then no bonus.

Result
When I press the Enter key the formula creates this result.
Copy the formula downward. When you are satisfied that the formula is
correct, then you would copy the formula down where needed on column C.

You can also generate a value, not just text, when using an =IF statement.
See below for a formula that generates a sales bonus. If the salesperson sells
more than $11,000, he or she receives a 5% bonus based on what they sold.

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com


The World’s Shortest Excel Book TWSEB - 17

Website: http://yourexcelcoach.com/
Email: rich@yourexcelcoach.com

X. Sheet Tabs – 255 Ways to Succeed
Excel has 3 sheet tabs by default.  Potentially, you could set the next
spreadsheet to a maximum of 255 sheets. Click the Excel Office Button,
Excel Options, Popular, When creating new workbooks, and then set
sheets to 255. The next Excel spreadsheet you create will have 255 sheets.

Use the Physician Expense Tracking.xls file and the sheet named
All Doctors.

Three Sheet Tab Concepts

 The basics. 
 Replication of sheets (my phrase, Excel doesn’t call it that). 
 3-D Formulas. This is when you spear the same cell from all or some of

your sheet tabs in the file. 

The Basics
If you right mouse-click any sheet tab at the bottom of your spreadsheet, you
can insert, delete, rename, cut and copy a sheet. Using a blank spreadsheet,
practice right mouse clicking a sheet tab to learn that skill.

Replication
I call this replication where I have 10 departments in the same file. Each
department has the same types of revenues and expenses, only the actual
numbers are different. I also want an 11th sheet tab for Departmental
Totals. How could we use sheet tabs to make this work?

Use the steps at the beginning of this chapter on Excel Options to create a
spreadsheet with 11 sheets. Click the OK button. Then request a new file from
Excel. The new file will have 11 sheet tabs.

Select all sheets. Right mouse-click any of your blank sheet tabs and issue
the command Select All Sheets. All eleven of your sheet tabs will now
appear at the bottom of your spreadsheet in white (selected).

Now, carefully type and build your spreadsheet. Whatever you type will
appear on every one of your worksheets. Try it, it works.

To turn off replication, just click any one of the bottom sheet tabs.
(Sometimes you may need to click an individual spreadsheet and then mouse-
click a sheet tab to turn off the selection.) You will know your spreadsheet is
back to normal when only one sheet tab appears in white at the bottom of the
spreadsheet.
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3-D Formulas
A multi-sheet
spreadsheet allows
you to build multi-
sheet formulas. Let’s
say you keep track of
30 physicians and
their expenses in a
hospital. The
snapshot to the right
is the Dr. Jackson
sheet tab.
In real life there would be many more expenses and many more doctors.
The key thing is that you want totals for all doctors.

In real life you would have 31 sheet tabs shown below. But we are only
showing the three sheets: two doctors and a total sheet.

Start by spearing your first cell, B4:

Mouse- click the All Doctors sheet to make it active. Then click cell B4. You want
to total Jan Salary for all 30 doctors (just Jackson and Brown in this demo).
In cell B4 type the formula =SUM(Smith:Brown!B4) . Press Enter. (If this
were real and you were tracking doctors Adams through Zenia then the =SUM
formula would have the names Adams and Zenia.) See the example below.

Use Copy. If spearing works on one cell, they will all work. Just copy the
formula of cell B4 to any other cell in the All Doctors sheet tab. Try it. It
works.

Example.  If you need help, just study cell B8.  It’s a 3-D formula.
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XI. Understanding Pivot Tables
A pivot table is a hybrid software technique that’s part spreadsheet and part
database. When managers see a pivot table for the first time, they want their
staff to build one for them. (If the phrase pivot table is new to you, you can
find more information in Excel’s help system.)

Use the Sales Pivot Table, 2011.xls file and the sheet named Pivot Table
Problem.

What does a pivot table look like? Let’s take a look at a simple database in
Excel and then process the data as a pivot table.

Here’s the BEFORE picture of a
sales spreadsheet before it’s
been processed or re-done as a
pivot table. A manager might ask
for sales totals by customers. Or
maybe a manager wants to see
sales by product and then by
salesperson. In an effort to
please their manager, users may
sort, count, do anything they can
to give the manager what they
want.

Here’s the AFTER picture when the data has been processed or re-done as a
pivot table. The tiles Customer, Product, and Salesman are moveable to
give you different views or perspectives on the data.
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How do I build a pivot table?

I can’t teach you everything about how to build a pivot table in one page. After
all, some people have built careers out of using pivot tables. But, I can give
you some advice to experiment with and to use.

Click anywhere in your sales database. Click Insert on the ribbon, PivotTable
icon, and PivotTable.  You will then see the CreatePivot Table panel:

 Verify that Select a table or range radio button is already highlighted.
 Verify that the New Worksheet radio button is highlighted.

(Please note that in the snapshots above and below, there is normally a wide
space between the Drop Data and Field List.  I made the space fit this page.)

With your mouse, drag the Sales tile
from the PivotTable Field List on the
right into the big area that says Drop
Data Items Here.  I always drag the
numerical field FIRST into the big blue
area. Excel will then look like the
screen at the right. Don’t panic. Drag
the Salesman tile into the
Drop Page Fields Here area. Drag
the Product and Customer tiles into
the same area. You’re done.

Refer to the previous page to see your finished pivot table. With your finished
pivot table, experiment moving the different Salesman, Product , and
Customer tiles to different positions. The data will stay the same, but how you
see the data changes.
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XII. Excel Charting:  Three Powerful Concepts
Bad news.  I believe charting in Excel 2007 and Excel 2010 are harder to
use than previous version.  Why?  Excel no longer uses the Chart Wizard.

Use the ExcelLearningFile.xls file and the sheet named Adjacent
Charting Problem.

Three concepts to better Excel charting.

 Adjacency. When the data you wish to chart is all together in one
rectangle or range. 

 Non-adjacency.  When your data is scattered in two or more ranges. 
 Customizing.  When you just want to make your charts look better. 

Adjacency.
When all your data for charting is together in one range, charting is very easy.
First, highlight the range you want for a chart.  Second, click the Insert tab.
Third, click the Column icon for a column chart.  Lastly, click the chart type
you want (for example, column charts or pie charts).

Note: The key to
charting in Excel is
knowing what data to
highlight.  It does take
practice.  Begin with
simple charts of
adjacent data.  Then
you can try to
experiment with non-
adjacent ranges.

Non-Adjacency.

Many good Excel users don’t know that they can highlight two or more
different ranges for charting purposes. See below.

Note: If you had
highlighted A3:D7,
your resulting chart
would have looked
confusing.
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Non-Adjacency (continued)
To highlight two or more different ranges use the CTRL keystroke. To highlight
the non-adjacent range (shown on the previous page), follow these steps.

 Use the mouse and click on cell A3. 
 Hold down the Shift key.  Click cell D3.  Release the Shift key. 
 Your first range is now highlighted. 
 Hold down the CTRL key.  Click cell A5.  Release the CTRL key. 
 Hold down the Shift key.  Click cell D7.  Release the Shift key. 
 Your second range is now highlighted. 

You have successfully highlighted your range. Now, as explained on the
previous page, click the Insert tab, Column icon, and then select a chart type.

Customizing
I recommend simply right mouse clicking a chart object (a column, a grid
line, a title) to find out how to customize it.

More Notes on Excel Charting

 Automatic? Excel charting seems automatic.  It’s not.  If you build a
chart, ask a co-worker if the chart makes sense to them.

 Data selection is the key.  Think about what chart you want and then
select the data range properly before you click any icons.

 DynamicChange a number and the chart changes.  Change the height
of a column, and the number changes.

 Pie charts are different. You cannot do a pie chart of multiple expenses
over multiple months.  Pie charts are different than bar charts.

 Name your charts. For complex data charting, put the data on one sheet
tab and the chart on another sheet tab. It’s a good method. 

 F11 is fun. When you highlight your data you can press the F11 key to
get an instant chart on its own sheet tab. 

OLE – Object Linking and Embedding is powerful.

Problem.  If you build Excel charts you will probably paste those charts into
Word or PowerPoint. But then people change their Excel data and the chart
changes. Then they need to re-paste the new charts into Word or
PowerPoint.

Solution. Use OLE (Object Linking and Embedding). Do not paste your
charts into Word or PowerPoint. Use Paste Special to paste link your chart
into Word or PowerPoint. When the Excel data changes, it will update the
target file.
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XIII. The Tools Menu and Goal Seek
Before Excel 2007/2010, you could click on the Tools menu to find
advanced features all in one place.  Although the Tools menu is gone,
Excel still has the power to do spelling, goal seeks, and more.

Spelling – Click the Review tab, then click the Spelling icon on the ribbon. If
you have spelling mistakes in your spreadsheet, will anyone trust the accuracy of
your numbers and formulas?

Scenarios – Click the Data tab, then click What If Analysis on the ribbon.
This is a way to create worst/average/best case scenarios. With the click of
a button you can switch from worst case to best case. (Sales personnel
should love this feature.)

Formula Auditing – Click the Formula tab.  Then look to the right for Formula
Auditing icons.  If 20-25 percent of all spreadsheets contain errors (as some
researchers believe) why aren’t more people using this feature? And don’t
forget the “Secret to Excel”, CTRL `.

Insert Functions – Clicking the Formula tab displays the Insert Function
icon on the ribbon.  Most Excel users utilize at most ten formula functions.
Studying the Insert Function feature is a good idea.

Excel Options – Clicking the Excel Office Button and then the Excel Options
button is worth your time.  They were mentioned earlier in this ebook.  Study
them now to save time and effort later on.
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A Goal Seek Problem to Solve
Use the ExcelLearningFile.xls file and the sheet named Mortgage Answer.

Do you remember the =PMT formula used earlier in this e-book for calculating
a home mortgage? (Refer to pages 12 and 13). In that example, if you knew
the interest rate, the length of a loan, and the loan amount, you could
calculate a mortgage payment (not including taxes and insurance).

Understanding how to do an =PMT formula function doesn’t answer the classic
home buyer’s question: “How expensive a home can I afford to purchase?”

Use the ExcelLearningFile.xls file and the sheet named Mortgage Answer.
The formula is shown at the top
of the snapshot. With a 5% loan
over 30 years the home buyer
can borrow $280,000 for a little
over $1500 per month.

If interest rate and loan term stay
the same, the buyer is wondering
how much they can borrow if the
loan payment is $1900.

Goal seek can give you a simple way to solve this type of problem. Click
Data on the ribbon, What If icon, Goal Seek.  See below.

You set cell B9 to the value 1900. You allow this to
happen by changing cell $B$3. You are asking
Microsoft Excel to goal seek and determine the
loan amount that you can borrow.

You click the OK button to let Excel do the internal
calculations.

Excel calculates the new value of cell
B3. For a mortgage (principal and
interest) of $1900 you can afford to
borrow $353,935.07 from a lender.
Once you understand the potential of
the goal seek feature, you will look
for all sorts of ways to use it within
Microsoft Excel.
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XIV. The VLOOKUP Formula Function
=VLOOKUP belongs with a family of formula functions named Lookup &
Reference. Probably the two most commonly used formula functions in
this family are =VLOOKUP and =HLOOKUP. In this section we’ll take a
look at =VLOOKUP.

There are two main uses of =VLOOKUP: exact matches and approximate
matches. An exact match for an =VLOOKUP would be comparing a short list
of items with a long list in order to find a match. An example of an
approximate match for an =VLOOKUP would be using a tax table. You earn a
certain income, but it doesn’t perfectly match the table you are searching. It’s
approximate.

Let’s take a close look at learning how to use an =VLOOKUP to solve an
exact match problem. Here are the business details.

 Whenever there’s a sale, you receive a list of items with sales ID’s only. No
description of the product is given. But you need to know the description of
the product because it’s too hard to memorize (and you’re new at the
company). 

 Currently, you take the sales order with its 20-30 different products and
compare it to a list that’s 100 lines long. Although you type pretty quickly,
finding the matches is tedious. 

 If this problem seems easy to you, be glad you’re not in the insurance business.
I worked with a client that had to compare a short list of hundreds of items to a
long list with thousands of items. They did this once a week, and made errors,
and hated the process. 

 Let’s visualize the problem, see below. 

What thousands of Excel users do across the world is manually look up what
an M3 sales item happens to be from the right list, then they copy it, then they
paste it to the right of M3 on the left spreadsheet. An M3 sales item is a 50
pound roll of roofing underlayment. What should they be using? An
=VLOOKUP formula function would solve the problem.
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First, please open the Excel file VLOOKUP and Sales Orders which came with
your e-book. There are 3 worksheets: Sales Order Problem, Product List,
and Sales Order Solution. The solution is obviously the 3rd workbook. Don’t
look at the solution for now.

Before you build your =VLOOKUP formulas in column B of the first worksheet
(Sales List) you need to do a few housekeeping chores.

 Verify you don’t have any duplicated items in the Product List worksheet.
=VLOOKUP does not work if there are duplicates in this list.

 Sort the Product List (2nd workbook) in ascending order. =VLOOKUP can
malfunction if sorting isn’t done in the lookup table. 

 Name the range A4:B13 on the Product List workbook. This is done by first
highlighting that range. Next, observe the formula bar. Finally, type the range
name allproducts in the formula bar where you see A3 (see below). 

Now, finally, you’re ready to build your =VLOOKUP. Go to the first worksheet
named Sales Order Problem. Click on cell B4 and type in the formula that
you see below. Remember, the formula is the =VLOOKUP, the result is the
phrase 50 pound roll of roofing underlayment.

So what does the =VLOOKUP formula mean?

 =VLOOKUP is how the formula begins. 
 A4 refers to the cell being analyzed. 
 allproducts refers to the name of the lookup table. It was pre-defined

by you. That’s why I had you name that range allproducts.
 2 is the column offset. It tells Excel to “return” a phrase from the 2nd

column of the named range when a match is found. This was the column
with the product descriptions. 

 False tells Excel that you only want exact matches, not approximations. 

Well done. If you need to do an =VLOOKUP for an approximate match like
a tax table, read the Excel help and use a True statement in the formula.
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XV. Your Excel Coach has a Forum – Join Us Today.
Thank you for purchasing this ebook. It is an honor that you have chosen me as
Your Excel Coach.

In 2004 I wrote an ebook named The World’s Shortest Excel Book and
marketed it with Google pay per click advertising around the world. My ebook
was purchased in 40 countries.  It was fun.

But I knew something was missing. I wasn’t interacting with my readers, helping
them with advice, or teaching them across the Internet.

Seven years have passed and I’ve returned to the Internet.

Things are different now.  WordPress allows me to build a nice website named
http://yourexcelcoach.com/ .  I can teach people privately or in webinars over the
Internet from Chicago to anywhere in the world using a high speed cable
connection.

The biggest change in 2011 is that I can easily build an Excel forum for my paid
subscribers to send me questions, get my advice, and share their Excel success
stories. Even though I believe my little ebook is a good idea, I believe a
worldwide community of Excel learners in a forum is a great idea.

Your purchase of The World’s Shortest Excel Book includes your first free month
in the Your Excel Coach forum.  I hope you visit the forum so that I can coach
you to the level of Excel expertise you want for your career.  The $20 fee for the
Excel forum is automatically renewed monthly and you can cancel at any time.

Read the ebook, study it on the bus or train to work, practice with it.  And please
visit Your Excel coach at our forum.  Yes, it’s our forum together.

Best Wishes from Chicago, IL USA.

Richard Kraneis
Website: http://yourexcelcoach.com/
Email: rich@yourexcelcoach.com

http://yourexcelcoach.com/
mailto:rich@yourexcelcoach.com
http://yourexcelcoach.com/
http://yourexcelcoach.com/

